Chapter 5 - CDOT MicroStation Workflow

Now that you are comfortable working in a MicroStation design file, you are ready to learn how CDOT
specifically uses MicroStation in the project process. This section concentrates on how CDOT creates model
file graphics by utilizing the CDOT Menu. It also covers the sheet file creation process. Once your sheets are
created, you will learn how to annotate, dimension and plot the sheets.

Creating a CDOT Project

This chapter is a general overview of the entire CDOT workflow to complete a CADD project
using MicroStation. You will learn how to set up a CDOT project and create your design model
file and reference other discipline’s files.

CADD Workflows

Model files vs. Sheet files

To understand how CDOT uses MicroStation for design and drafting, you first need to
understand the difference between Model files and Sheet files. Model files contain the design
graphics. These are the working files for your design. Each group has at least one Model file,
but can have multiple model files for different types of graphics. For example, the Roadway
Design group can have a model file for plan graphics and another model file for profile
graphics. The Traffic group may have separate model files for signs, signals and lighting.

Model Files

Design/Specialty Group = |
Plan graphics \ = . ]
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Sheet files are the files that will be plotted for the creation of a plan set. Sheet files reference
model file graphics. A reference is just a MicroStation file attached to your active file (the file
you have opened). You can reference multiple model files to create a sheet file. For example, a
Bridge general layout sheet may reference the existing survey/topo model, the proposed
roadway design model and the proposed bridge model to show all of the needed information on
the sheet. A Plan Profile sheet (shown below) references the proposed roadway design model
and the profile model.

Sheet files typically do not contain design graphics since they are referenced in from the model
files. You can’t modify the model file reference graphics in a sheet file; they are there for
information only. The sheet files, however, do contain the border and associated information
(bar scale, north arrow, etc.) along with text and dimensions, which can be modified since these
elements are placed directly in the sheet.

Model Files

Sheet File

—

o x w00 2
Border, Bar Scale, North Arrow and RE info.
placed directly in the sheet file
For more information on References, see the section Referencing Other’s Work in this chapter.
Model File Workflow for Survey/ROW

To create existing model files, the Survey/ROW group uses MicroStation and InRoads Survey
to reduce the electronic fieldbook data and create model files for ROW, survey planimetrics
and existing topographics. These existing model files can then be referenced by Design and
specialty groups as a base for creating the proposed model files.
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CDOT MicroStation
Model File Workflow

Survey/Row Group
Model Files
Electronic I I
Fieldbook JPCESURY_TopoCodest#Scalaf# dgn [

JPCESURV _TopoElevationahilt S cal o dgn

JPCESURVY _TopoEmorsf#Scaled® dgn
Reduce
daty JPCESURV_TopoNameshlScale##.dgn
JPCHSURV_TopoNoteshitS calaf# dgn

InRoads Survey & i- JPCASURV_TopoSymbolshiS caledt.dgn
MicroStation

Fefewnce

-

Model File Workflow for Roadway Design

~

JPC#ROW_Modeldgn
JPC#SURV_Model.dgn
JPCHSURV_Topol#S cal ot dgn

References for Design
and Specialty Groups

To create proposed design model files, the Roadway Design group references the existing
survey/topo and ROW models to begin the design. MicroStation and InRoads are then used to

create the proposed graphics in various model files — plan, profile, intersection, etc.

Occasionally, other specialty group model files are needed by Design, so these model files may

be attached as reference files.

CDOT MicroStation
Model File Workflow
Design Group

Model Files

From Survey/ROW I

[

JPCADES _Model.dgn
JPCADES_Profdgn
JPCHDES Interchange.dgn
JPCADES Infersec.dgn
JPCADES_Phasing.dgn

~

JPC#ROW_Model.dgn

JPC#SURV_Model dgn -
JPCHSURV_Top o##Scalet# dgn

®
&

Specialty Groups
Model Files
{as needed)

Bridge
JPC#BRDG_Model dgn
JPCHBRDG_Prof.dgn

Hydraulics

JPCAHYDR_Modeldgn
JPCAHYDR_Prof dgn

~

\ Landscape & Enwv.
JPCHLAND_ENVI_Model dgn

u

Utility
JPCRUTIL Model dgn
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Model File Workflow for Specialty Groups

Each specialty group references the Roadway Design group’s proposed model file to begin
their design. MicroStation and other specialty programs are used to create the graphics in
separate model file(s) for each group. When a specialty group references Design’s model file,
they can choose to reference the existing model file(s) from the Survey/ROW group as well.
This way, both existing and proposed graphics can be displayed in the specialty group’s model
file, if needed.

CDOT MicroStation Model Flles
Model File Workflow " Bridge
Specialty Groups rermnoo putm
<| rl'
= Hydraulics
l From Survey/ROW l From Design JPCHHYDR_Model dgn

JPC#ROW_Modeldgn

JPC#DES_Model dgn < l l-l'

JPC#DES_Prof.dgn
Landscape & Env.
JPCRLAND_ENVI_Model.dgn

L

L
[

JPCHSURV_Model dgn
JPCHSURV_Topo##S calebi.dgn

~N—

Traffic
JPC#TRAF_Light.dgn

JPC#TRAF_Model.dgn

JPCATRAF_Signal.dgn

Utility
JPCAUTIL_Model dgn

=

Sheet File Workflow for Roadway Design

To create sheets (specifically plan or plan/profile sheets in this example), the Design group
creates a new MicroStation design file for each sheet. Then, the proposed model file is
referenced into the sheet file. Since the proposed model also has the existing model file
referenced, the survey graphics can be displayed in the sheet. The sheet file view is rotated, if
needed, so graphics appear horizontal. Then, only the portion of graphics needed for the sheet
is “clipped” out from the reference. The border, north arrow, bar scale and Resident Engineer
information is then placed directly in the sheet file via the CDOT Menu. Many generic sheet
files also contain a border, which can be edited. The sheet can be annotated with MicroStation
text and the reference graphics dimensioned, if required. Unlike reference graphics, text and
dimensions are placed directly in the sheet file and, therefore, can be edited in the sheet.
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Other sheets such as detail, title, general notes, etc. have specific requirements, but use the
same general premise of referencing the model file(s) to the sheet file. Typical Section sheets
are an exception to the rule, since graphics are created directly in the sheet file using the CDOT
Typical Section Program.

CDOT MicroStation MicroStation Ted

Sheet File Workflow D iE IR EE
DESign GI'OUP MicroStation Dimensions
N T n
Model Files l
From Survey/ROW From Design I Sheet Files

I

[ I s

JPCHROW_Modeldgn

JPCH#DES_Model.dgn JPCEDES_PnP##.dan

JPCH#SURY_Model dgn

JPC#DES_Prof.dgn JPCHDES_Plard#. dgn

JPCH#SURY_Topod#Scale## dgn

~N— . SN

S (T e = lok]
g i hET
4 “a
ver

North Amow
Cell

MicroStation
Cells

Bar Scale
Cell

Region Eng.
Cell

Sheet File Workflow for Specialty Groups

Specialty groups create a separate MicroStation design file for each sheet, and then reference
their own model file(s) into the sheet file. Since this model file can also have Roadway Design
and ROW/Survey’s model files referenced, these graphics can be displayed in the sheet. The
sheet file view is rotated, if needed, so graphics appear horizontal. Then, only the portion of
graphics needed for the sheet is “clipped” out from the reference. The border, north arrow, bar
scale and Resident Engineer information is then placed directly in the sheet file via the CDOT
Menu. Many generic sheet files also contain a border, which can be edited. The sheet can be
annotated with MicroStation text and the reference graphics dimensioned, if required. Unlike
reference graphics, text and dimensions are placed directly in the sheet file and, therefore, can
be edited in the sheet.
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Other sheets such as detail, tab, and note sheets have specific requirements.

CDOT MicroStation
Sheet File Workflow

Model Files
I From Survey/ROW From Design Specialty Groups
[
1 : [ L L
JPCRROM ModeLd JPCABRDG_Model.dgn
= 2 SPCIORS Madedgn JPCRHYDR_Model dgn
JPC#SURV_Model.dgn cos 'P . JPCALAND_ENVI_Model dgn
JPC#SURV._Topeo##S cale## dgn AlEs A JPCETRAF_Model.dgn
q JPCRUTIL_Model dgn
MicroStation Text L l
A 2L 0 » :
Sheet Files
MicroStation Dimensions
] >
BHKS S \J_f_
Border
Cell

Single Source Project Data

—

MicroStation

Cdls
Region Eng. Bar Scale
Cell Cell

The use of MicroStation references is a powerful tool that allows all users on a project to share
graphical data files from a single source. You should always access graphics files from a central
location, either on a project server or from a Project Manager’s machine. This eliminates the
need to copy graphics files to multiple machines when several users are working on a project.
Copying graphics files out of their project location is bad practice and should be avoided.
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You can use MicroStation to reference files you need from other groups, and multiple users can
reference the same file. The “owner” of the file can continue working on it while those
referencing the file can see the updates. This way, the file remains in a central location and
you’re assured that you’re working with the latest version of that file.

Design

ROW/Survey

T

e Hydraulics

/7 N Single-source ii4
roje i, R— .11 ' : ;
Manager’'s # (0 Materis Mgiachrc ) > 2

° Directory
computer or

network drive
Traffic/ITS

&

Landscape/Env.

Project set-up

The Project Manager (PM) is responsible for setting up a new project. To take full advantage of
single source data, the project directory is created on either a network sever or on the PM’s

personal computer. All users working on a project would then need to map the PM’s machine in
order to access the project directory.

The Create Project Directory Utility

To create the project directory, the Project Manager runs the Create Project Directory utility.
The utility is found on the Windows Start Menu (Start > All Programs >
_CDOT_CADD_Information > Create Project Directory Structure).

) CDOT Project Creation Utility (ol = =
Project Template: Workspace\Workspace-CDOT_XM\Project Template lz‘ Apply
Destination: C:\Projects lz‘

Close
Job Project Code (JPC): 2345

: s About...
[¥]Create Project Configuration File ou
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The PM enters the Job Project Code (JPC) and runs the utility. This creates the project directory
and associated blank and auto-populated files, along with the Project Configuration File (PCF).

The project can either reside on the Project Manager’s computer or on a network drive. If it’s
on the PM’s machine, make sure this drive is shared to others working on the project. To create
the project on a network drive, select the Browse button (...) next to Destination and then
select Open.

lsw8) CDOT Praject Creation Utility =l = ==
Project Template: WorkspaceWorkspace-CDOT_XMVWProject Template lz‘ m
Destination: CWProjects =
Job Project Code (JPC): 12345 Open
Create Project Configuration File C\Projects

You can now set the path to any mapped network drive.

Browse For Folder =3

Select Destination Path:

Bl Desktop
- |E cpoT user
. Public

4 M Computer

» &, Local Disk (C)

» = DVD RW Drive (D:)
> W Network
Control Panel

A
E

Recycle Bin

[ oK ][ Cancel ]

For more information see the CDOT CADD Manual, Chapter Three —Project Directory

Structure, section 3.1 — Project Creation Utility.
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The PCF file

The Project Configuration File, created by the utility, defines a specific directory that
MicroStation defaults to when opening up a DGN file or referencing model files. PCF files are
extremely useful when multiple users are accessing the same project directory across the
network, or when DGN files are moved from one directory to another.

Working in a server environment

If multiple users are accessing the same project directory, the PCF file will need to be
distributed to everyone on the team accessing the project directory. Each member of the team
should have their own copy of the PCF file and it should be saved to the same location,
C:\Program Files\Workspace-CDOT\Standards-Local\Projects. The PCF is also useful for
managing references. If a reference file is moved, you should never have to reattach it. You can
use the PCF to manage the reference locations.

|
COIO’. ado CADD & Engineering Innovation

Projects | Employee Info | Teams | Organizations | Resources | Contacts | News | Help

CDOT Work Flow

Work Flow :

CDOT Alignment Display in Cross Section.Ink

CDOT Annotating Horizontal and Vertical Alignments.Ink
CDOT Batch Printing.Ink

CDOT Batch Processing.Ink

CDOT Configuration ReadMe file.Ink

CDOT Converting AutoCAD Files to MicroStation.lnk

CDOT Creating Multiple Plan Sheets.Ink

CDOT Directory Structure.nk Useful Links

CDOT Digplaving Features in Cro tion and Profile.lnk
CDOT Exporting Fieldbook Files.Ink

CDOT Greek Characters.Ink

CDOT Level Update for V03.01.Ink

CDOT Linking MicroStation to Excel Documents.Ink
CDOT MicroStation Printing.Ink

CDOT Mote Sheets.Ink

CDOT PCF Management.Ink

When team members are sharing the Project Manager’s machine, the PCF file will need to be
edited. See the Workflow CDOT PCF Management for more information.

The CDOT Project Directory Structure

The Project Creation utility creates the project directory structure on the server or PM’s
computer. All CDOT projects should follow this structure to ensure the accurate sharing of
information between groups within the Department as well as outside consultants. The CDOT
Project Directory’s top level designates the project code. Below this folder is a set of
standardized sub-directories for each CDOT specialty group. Under each specialty group folder
is a sub-directory structure unique to that specialty group.

Colorado Department of Transportation Page 60



Chapter 5 - CDOT MicroStation Workflow A Practical Guide for Using MicroStation XM

For more information about the CDOT project directory structure, see the CDOT CADD
Manual, Chapter Three — Project Directory Structure, section 3.2 — Directory Structure.
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Training Project Directory

For this training class, you will create a project directory structure with an example Job Project
Code (JPC) of 12345 shown below. The Roadway Design group’s sub-folder is shown
expanded to show an example of a group’s sub-folder structure.

=l |J) Projects
= ) 12345
+ ) Bridge
+ | Construction
|2 Consultants
= |2 Design
() Calculations
() Correspondence
=l | Drawings
() Cross_Sections
() Reference_Files
() Tabs
() InRoads
) Photos
) Reports
() Working
|) Hydraulics
|2 Landscape_Environmental
I) Materials_Geotechnical
) Miscellaneous
|2 Planning
() Plot_Sets
() Project_Configuration
+ ) Project_Manager
) Redline
L) ROW_Survey
I2) Spedifications
I | Traffic_ITS
i) Utilities

+ I+

o

+

+

+

+

+

Training files

The training lab files for CDOT CADD courses can be accessed from the Windows Start Menu.
Select Start > All Programs > _CDOT_CADD_Information > V08.09.XX-XM >
Training Files > Insert training files on my computer. A link is also available on the
Training page of the CDOT CADD web site.

CDOT file naming convention

Model files and Sheet files need standard, informative, and unique names to allow easy
identification of the specialty group responsible for the file and the type of information
contained within the file. All CDOT CADD drawings created should follow this naming
convention so the data can be easily identified and shared by all users.
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The CDOT file naming convention contains the Job Project Code, a specialty group identifier,
short standardized file name, an optional annotation scale identifier, an optional description,
and file extension.

Specialty Annotation Scale

Job Project Code Group (optional) ) )
File Extension

JPCHXXX XXXXHFHHEXXXYYY

Standardized Name Descripton
(optional)

An example of a MicroStation design file would look like the following:
12345DES_Model100US285.dgn

12345 indicating the CDOT Project Number, DES indicates it is Roadway Design’s model file
and 100 indicating it uses a 1”’=100" annotation scale, US285 is a description identifying the
highway this model depicts. . DGN is the default extension for MicroStation design files.

Note: A seventh segment is used on Working Files. This segment should be the initials of the
designer or engineer who is working on the file.
Example: JS12345DES_Model100.dgn where JS, are the initials of the designer or
engineer (in this example, JS stands for “John Smith”).

For more information about the CDOT project directory structure, see the CDOT CADD
Manual, Chapter Four — File Naming Convention.

[ QI [ P (Se— e e ]
R o N e
n

| 4.0 Chapter Four - File Naming Convention

- 4.1 File Naming Convention

Auto-populated files

In addition to creating the project directory structure, the Project Creation Utility also creates
several auto-populated drawing files that have the CDOT standard file names already assigned
The # symbol is used for the counter. When creating a new file, one option is to open the
appropriate auto-populated file in MicroStation, select File > Save As and then rename the
file.
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The diagrams below shows an example of auto-populated files automatically created for the
Roadway Design group.

Folders

Folders

Design ~
. Calculations
. Correspondence
. Drawings
y Cross_Sections
Reference_Files
Tabs
. InRoads
, Photos
. Reports
. Working
Hydraulics
Landscape_Environmental

m

Materials_Geotechnical
Miscellaneous
Planning

. Plot_Sets

Project_Configuration
Project_Manager
Redline

ROW_Survey

=

. Drawings -
, Cross_Sections
. Reference_Files
) Tabs
InRoads L
. Photos
. Reports
Working
. Hydraulics -

What files go where?

Name

, Cross_Sections

. Reference_Files

) Tabs
F=12345_ Menu.dgn
F2{12345DES_EarthworkQuant##.dgn
F%12345DES_GenlNote®#.dgn
F2{12345DES_Plan##.dgn
F=12345DES_PnP#2.dgn
FZ{12345DES_Prof#2.dgn
F212345DES_SAQ#2.dgn
F=12345DES _StdPlanList.dgn
F3412345DES_SWMP.dgn
F=12345DES_TabConc##.dgn
F212345DES_TabMisc01.dgn
F=12345DES_TabMisc#2.dgn
F%12345DES_TabRem#=.dgn
F212345DES_TitleSht.dgn
F=12345DES_TyplSect2.dgn
F2123455URV_Tab.dgn
F=123455URV_WUTab.dgn
FZM&S Standard Plans List Index.dgn

Name

{F2412345DES Interchange.dgn

F=12345DES Intersec.dgn
F12345DES_Model.dgn
F212345DES_Phasing.dgn
F=12345DES _Prof.dgn

As you’ve learned there are two main types of CADD files for a CDOT project: Model files,
which contain graphics for referencing into sheets, and Sheet files which generally contain
either references to model files or non-design related items such as general notes, special
symbols, quantities, sheet borders, etc.
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Working Model files

Working files (or sketch files) are model files containing graphical data created during the
design workflow. These files should be placed in the "Working" folder in each group’s
sub-folder. The file name should include the designer's initials. These files are not to be
considered final design files, and should not be referenced to sheet files or other
reference model files. An example of a working file would be: //12345/Design/Working/

JS 12345Des Modell00.dgn

Folders
4 |y 12345

Bridge

Construction

Consultants

4 Design

Calculations
Correspondence
Drawings
InRoads
Photos
Reports
Working

Hydraulics

Reference Model files

m

-

Date modified Typ
7/28/2009 7:08 ... Mic

MName
E:.'j- DES_12345DES_Model100.dgn

The most up-to-date model files which are available to other groups for referencing, that
only have the most current non-sketch or working information in them, should be placed in
the group’s Drawing > Reference_Files folder. The designer’s or engineer’s initials
should be removed after moving this file.

Folders
Design

Calculations

Correspondence

Drawings
Cross_Sections
Reference_Files
Tabs

InRoads

Photos

Reports

Sheet files

MName

F2112345DES Interchange.dgn
5:.512345DES_Intersec100 SHE6.dgn
F2112345DES_Model.dgn
F2112345DE5_Model55.dgn
F2112345DES_Model65.dgn
F2112345DE5_Phasing.dgn
F2112345DE5_Prof.dgn

P2 Elbert.dgn
F2JQP_12345DES_Prof0l.dgn
F2JQP_12345DE5_Prof03.dgn

Sheet files are typically stored in a group’s Drawings folder, as shown.

Folders
Projects
12345
Bridge
Construction
Consultants
Design
Calculations
Correspondence
Drawings
Cross_Sections
Reference_Files
Tabs
InRoads
Photos

m

-
MName

Cross_Sections

Reference_Files

Tabs
5:.512345DES_E3 rthworkQuant.dgn
F2112345DE5_GenlNote.dgn
F2112345DE5_Plan02.dgn
F2112345DE5_Plan03.dgn
F2112345DE5_Plan04.dgn
F2112345DE5_Plan05.dgn
F2112345DE5_Plan06.dgn
F2112345DE5_Plan07.dgn
F2112345DE5_Plan09.dgn
F2112345DES_Prof0l.dgn
F2112345DE5_Prof02.dgn
FZ412345DES Prof03.dan
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Plot files

When sheet files are plotted to PDF, the plot files are placed in the project’s Plot_Sets
folder. Sub folders for AD, FIR, FOR and ROW are available.

Folders

.. Reports
. Working
. Hydraulics

.. Landscape_Environmental

. Materials_Geotechnical
. Miscellaneous
.. Planning
. Plot_Sets
. AD
. FIR
.. FOR
. ROWPR

-
MName

7)12345DES_Plan01-001.pdf
“ | "2112345DES_Plan02-001.pdf
7)12345DES_Plan03-001.pdf
7)12345DES_Plan04-001.pdf
7)12345DES_Plan05-001.pdf
7)12345DES_Plan06-001.pdf
7)12345DES_Plan07-001.pdf
7)12345DES_Plan08-001.pdf
7)12345DES_Plan09-001.pdf
7)12345DES_Plan10-001.pdf
7)12345DES_Plan11-001.pdf
7)12345DES_Plan12-001.pdf
7)12345DES_Plan13-001.pdf

[

Size
36 KB
13 KB
59 KB
36 KB
36 KB
13 KB
13 KB
13 KB
13 KB
59 KB
59 KB
59 KB
59 KB

For more information, see the CDOT CADD Manual, Chapter Three — Project Directory
Structure, section 3.2.2 — Group Sub-Directory Structure.
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See also:
o CDOT CADD Manual, Chapter Four — File Naming Convention, section 4.2
File Types

o CDOT Directory Structure Workflow.

The CDOT Workspace

The CDOT Workspace is a custom environment designed to facilitate CADD productivity and
direct the user to CDOT-specific standards, workflows and processes. The CDOT Workspace is
a complex set of configuration files, MicroStation and InRoads resource files, workflow
documents, and many other customized tools, all designed to work together to increase
productivity and efficiency, and allow for a standardized project plan set output. Some of the
items in the workspace include:

Seed files (starter files that contain MicroStation settings for creating new files)
Cell libraries (standard details, symbols, notes, etc.)

DGN libraries (standard level structures, text styles and dimension styles)

Line style resource files (custom line styles)

Font resource files (special fonts)

Plot drivers (for plotter configuration and PDFs)

Pen tables (for special plotting preferences for certain graphics)

InRoads preference files (for controlling InRoads graphical displays)

InRoads templates (for standard typical sections)

CDOT configuration files (to set the correct MicroStation resource files and other standard
files located on the user's computer)

Workflow documents (CDOT standardized procedures for specific MicroStation and
InRoads tasks)

CDOT Group Menus (access to tools and applications which provides a simple, efficient
method of applying CDOT’s CADD standards to every project)

The installation of the Workspace will be controlled and maintained by the Information
Technologies (IT) Department. You can manually update the workspace at any time by
selecting the Start > All Programs > CDOT_CADD_Information > Update
MicroStation-InRoads Standards.
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The CDOT workspace and configuration files are located on each user’s computer in the
C:\Workspace folder.

MName

Workspace-CDOT_XM

Folders
Workspace-CDOT_XM

CDOT Motes

Civil Data

Project Template

Standards-Global
CFG Files
InRoads
MicroStation
Redline

Standards-Local
Customizations
Prefs
Projects
Redline
Users &

m

The Select Group Environment Utility

The Select Group Environment utility automatically attaches the correct level libraries needed
for working on a CDOT project. This utility also provides CDOT users additional
MicroStation resources unique to their group (group-specific cells, seed files, linestyles, levels
and symbology, etc.) The utility must be run prior to starting MicroStation in order to set up
tools specific to that user’s group.

There are two group options: Bridge and xxMulti-Discipline. The multi-discipline environment
enables MicroStation to have all the cell libraries, level libraries and filters, available at
anytime with out having to load these items individually. The Bridge option loads just the
specific files needed for the Bridge group.

The Select Group Environment Utility can be run from the user’s computer through the Start
button Start > All Programs > _CDOT_CADD_Information > Select Group
Environment. You MUST exit MicroStation prior to running this utility.

E CDOT Select Group Environment =2 EcH(t==
Bridge oK
xxMulti-Discipline
Cancel
About...

For more information on the Select Group Environment, see the CDOT CADD Manual,
Appendix F - Select Group Environment Utility.

For more informattion on the CDOT Workspace in general, see the CDOT CADD Manual,
Chapter Two - CDOT Workspace.
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intranet Home | CDOT External | Search

COIorad CADD & Engineering Innovation

KT

Ueparimenisoisiranspor,
Projects | Employee Info | Teams | Organizations | Resources | Contacts | News | Help

CDOT Work Flow

Work Flow :

CDOT Alignment Display in Cross Section.Ink
CDOT Annotating Horizontal and Yertical Alignments.Ink

CDOT Batch Printing.ink
DOT Batch Processing.Ink

CDOT Configuration ReadMe file.Ink

=4 T R e errotation.Ink

CDOT Creating Muyltiple Plan Sheets.Ink

CROT Nirarrars Streicrurs Inl

Configuration releases

The IT Department is responsible for updating your computer when the CDOT workspace and
configuration is updated. For a detailed description on what’s in the new configuration release,
see the CDOT Configuration ReadMe workflow.

Col

orad CADD & Engineering Innovation

PETLIMBTINON

intranet Home | CDOT External | Search

Projects | Employee Info | Teams | Organizations | Resources | Contacts | News | Help

CDOT Work Flow

Work Flow : CADD Library
CADD Manual
CDOT Alignment Display in Cross Section.Ink
CDOT Annotating Horizontal and Yertical Alignments.Ink
CDOT Batch Printing.ink
DOT Batch Processing.lnk

CDOT Configuration ReadMe file.Ink

=4 T R e errotation.Ink

CDOT Creating Muyltiple Plan Sheets.Ink
CDOT Directory Structuré.lnk

T Displaving Features in Cro ction and Profile.lnk
CDOT Exporting Fieldbook Files.Ink
CDOT Greek Characters.Ink
CDOT Level Update for v03.01.Ink
CDOT Linking MicroStation to Excel Documents.Ink
CDOT MicroStation Printing.Ink
CDOT Mote Sheets.Ink
CDOT PCF Man t.ink
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You can also access this workflow and others (in PDF format) from the CDOT workspace in
the CDOT Notes sub-folder.

MName i
Folders v T CDOT Batch Processing.pdf
Workspace * | =)CDOT Breakline.pdf 3
Workspace- CDOT_XM " CDOT Calculate Volume.pdf
ECDOT Configuration ReadMe.pdf I
Civil Data 7 CDOT Consultant Server Setup.pdf
Project Template . CDOT Converting AutoCAD Files to MicroStation.pdf
Standards-Global T CDOT County Sheet Composer.pdf
CFG Files 7 CDOT Creating Combined Surfaces.pdf
InRoads 72 CDOT Creating Multiple Plan Sheets.pdf
MicroStation = -'; CDOT Displaying Features in Cross Section and Profile.pdf
Redline — | =CDOT Edit Text Along.pdf -
Standards-Local | ¢ m 3

The CDOT Level Structure

Thirteen Specialty Group Design File Level Libraries (DGNLIBs) are available for use within
CDOT. The level libraries are attached to the MicroStation design file via the Select Group
Environment utility and provide the CDOT approved standard discipline levels for use when
placing graphics. You can not create, edit or delete levels within the CDOT Workspace — you
must use the levels provided in the DGNLIBs. Likewise, you can not modify the level's
symbology, thereby maintaining “ByLevel” status for standardization purposes. ByLevel
symbology is used by default for all level libraries and is the required standard for plan set
creation. CDOT has adopted an “existing vs. proposed” leveling scheme, whereas with the use
of pen tables, all existing design data will plot gray scale. Level duplication across disciplines
has been avoided wherever possible.

Level libraries (DBNLIBs) are stored in the CDOT workspace (C:\Workspace\Workspace-
CDOT_XM\Standards-Global\MicroStation\DGNIib).

-

MName
Folders v Standard
“ | @ Alignments.dgnlib
Waorkspace-CDOT_XM ] Bridge.dgnlib
CDOT Notes ] Construction.dgnlib
Civil Data ] GIS.dgnlib
Project Template ] Hydraulics.dgnlib
Standards-Global ] Landscape_and_Environmental.dgnlib
CFG Files ] Materials_and_Geotechnical.dgnlib
InRoads M Roadway_Design.dgnlib
MicroStation M ROW.dgnlib
AutoCAD Commands ] Topo.dgnlib
Batch Plot ] Traffic.dgnlib
Cell ] Utilities.dgnlib
[ata =
exes
Interface
Macros -
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For more information about the CDOT level structure and a list of all discipline level libraries,
see the CADD Manual, Chapter 5 — Drafting Standards, section 5.3 — Design File Level
Libraries. You can link to a specific group to review its standard level structure.

roup Evesign File Level Liow

5.3 Design File Level Libraries (Level definition files)

s witin COOT. The wnunnunnumm

starcufor lam ol coveton. COG b ackphec s exstiog . proposedt
Oxvor deia ol ot gray wal. S Clptn 10e ke
wherever pessible

e Ses Lkt i ren pric b etening Design File levets
Mx e the COOT appr The COOT andj i
Bevel's SymEciogy, theroby mamtaming ‘Bylever status for Tre o intent

afnbuses for color, Inestyle and wesght from the level St i seloctod Mm«.mummmmraummm a1+ T regured
al eestog

— boope ]  Consnete ] @ Cueg |

. L drsciphnes P bwen avded

Useful Links

ALG_ALTEIATE Coge
ALG_ALTESHIATE_or Aagreven
ALG_ALTESIIATE tos Adgrevaeen 51a-Magss
ALG_ALTESHIATE tos Adrore StaMhois
ALG_ALTERNATE or-Mdgpemest Tt
ALG_ALTESIIATE Vs Commaly
ALG_ALTESIIATE Vor iirypames
ALG_ALTERNIATE _tioe Kirypeses Test
ALG_ALTESIIATE s Tangent Lines
ALG_ALTESIIATE Voo Tangeen Tost
ALG_ALTESHIATE Vs -Kigreveen
T

ALG_ALTERIATE Vs Abggenent Text
ALG_ALTERIIATE Ve iirypamen
ALG_ALTERNATE Ver Krypasts Tet
ALG_ALTERIATE Ve Tasegunt Lines
ALG_MTERIATE Vi rm Tt

Kprimn Woed Cantpios (s
Kerie o Ky Uari Simcnns

K oo iy Lo S

A g CL Tangaet & e dssatian pass]
Anprimna Hosa. orypamin) Loscies &
A W orypees w0 caBo e P8 . 0. ) ool 0wy o]
Kismva o et o8 e 1ymmbabogy
Mg st Coret fuasiens] Tangaety fies]

G5 | Hycwdes | _Landscape aod Envrcomenta) |
Ry I - | Suney |
Deson B
Tmiic ] Likes ]
5.3.1 Anafingd Level Libraries
The CODOT i L] A 'y 1 ot ARaChed.
aoncr eactlboll a hy it Spacialy Group bvel Beary. USers can altach bevel Bocanies indnduady of gat
Thoe s (fcillins Livel Library sefing is sl by dedault whers svbally opering MicroStation This sefting aflaches al e avadabis CDOT
BC1os Graipnes. TR 1S the recommenced kevel SOrary that shoukd be aZacted
fer sciplnes.
The Drafting . by delut basic drating
L lasoid By Grongy Weveds. soukd be et SpeCiles vl
g oo with RRoads of that wil a5 a model Drating Levets shoukd be apphed 10 o dramengs
hat ‘ * sheet files.
Cml 0D (2 D — )
Aligament Levels
Mame escripion LomiCular Loveiighs Lovetiel

Abperms Coge Proes [cod. vyt fost feat|

8 W) o]

Aneatann

P or, W) o]

A Word Caten foenl) Tavgees dnactangn fyest]
Aermren Ve Lines, Arc [Wsewaeh|

Apertrs Vo Cusve Deraniess [winess bean o]
Agrtres Ven Cusve & Tangaes Arvataton [l

Aty Ven, Kypaes (g, 4. o, o ool
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Level naming convention

The standard CDOT level naming convention shown below is used to allow for easy filtering of
levels in MicroStation’s Level Display or Level Manager.

ALG_APPROACH_ROAD_Hor-Alignment

DGNLIB abbreviation J

Main filter name or category ——

Secondary filter name or category (Optional) e—

Secondary description word (Optional)

Main description word
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Levels and configuration releases

When a new configuration is released, it is not unusual for the CDOT Standards and
Configuration committee to add, change or delete levels from the level libraries. If you’'re
working on a project, you will need to update the used levels in a design file to the new
configuration standards. Each new configuration release includes a comma separated variable
(CSV) file that maps old levels to new levels. You will need to apply this level mapping to all
existing files that you wish to update to the new configuration. Refer to the CDOT Level
Update workflow for more information.

,
chlqrado CADD & Engineering Innovation

Projects | Employee Info | Teams | Organizations | Resources | Contacts | News | Help

CDOT Work Flow

Work Flow :

CDOT Alignment Display in Cross Section.lnk
CDOT Annotating Horizontal and Yertical Alignments.Ink

CDOT Batch Printing.Ink

CDOT Batch Processing.Ink

CDOT Configuration ReadMe file.Ink

CDOT Converting AuteCAD Files to MicroStation.Ink
CDOT Creating Multiple Plan Sheets.Ink

CDOT Directory Structure.lnk

CDOT Displaying Features in Cross Section and Profile.Ink
T Exporting Fieldbook Files.Ink

I CDOT Level Update for V03.01.Ink

CDOT Linking MicroStation to Excel Documents.Ink
CDOT MicroStation Printing.nk

CDOT Mote Sheets.Ink

CDOT PCF Management.lnk

Creating a new CDOT Model file

When you’re ready to create a new model file to begin your work, you have two options:
e C(Create the new file from an auto-populated file

e (Create the new file from a seed file

Creating a model file from an auto-populated file

Auto-populated files are created by the Project Creation utility. The model files are created in
the group’s \Drawing\Reference_Files folder. You can rename these files and save them to the
project’s \Design\Working folder to create your new model file.

Creating Model files from seed files

A seed file is a “starter” file. It has all CDOT standard settings for each specialty group. Seed
files are either 2D or 3D, so make sure you choose 3D when creating model files.
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See the CDOT CADD Manual, Chapter Five — Drafting Standards, section 5.2 — Seed files
for more information.

CADD Library

Useful Links

CDOT default settings

When a new file is created from a seed file or auto-populated file, there are several settings
already established that conform to the CDOT standards. Two important settings include
Working Units and Coordinate Readout.

Working Units

The working units in either a 2D or 3D file determine the measurement system for the design
file. Working units are defined as:

e  Master Units:Sub Units
e MU:SU

You set a design file’s working units for any desired measurement system. For typical imperial
units (English), you could set Master Unit to feet and Sub Units to inches. The working units
would then be expressed as 1:12. If you set Master Units to Feet and Sub Units to tenths of a
foot, your units would be expressed as 1:10.

CDOT standard Working Units

CDOT standard working units are 1:12 and expressed as:
¢ Master Units = Survey Feet (’)

¢ Sub Units = Survey Inches (”)

There are two types of unit definitions for imperial feet — survey and international. These
have a slightly different conversion factor from metric. CDOT uses the survey foot
definition.
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The working units settings are found under Settings > Design File > Working Units.

4 DGN File Settings 2
Category Modify Working Unit Settings
Active Angle Linear Units
Active Scale Format: (MU »| | Custom
s Master Unit: |Survey Fes = | Label: °
Color Sub Unit: [Survey Inc = | Label: | Cancel |
Element Attributes Accuracy [0.123 -
Fence
Grid Advanced Settings
lsometric Resolution: 12000 per Distance Survey Foot
Locks Working Area:  1.42155E+008 Miles
; Solids Area:  157.829 Miles ——
Renderin -
Snaps o Solids Accuracy:  8.33333E-006 Survey Feet Edit
Stream Angles =
Views Format; L_
Working Units Mode: L
Accuracy: [ .
Focus ltem Description
Select category to view.

Entering data

When you enter data for lengths, distances, etc. you use the format for working units:

MU:SU. You can enter data in just master units, just sub units, or both. For example, if your
working units are 1:12 (feet and inches), and you want to place a line with a length of 1 foot

1 5 inches, you could enter the length as:

¢ 1125
¢ 11112
¢ 13122

Note: You can use either fractions or decimals when entering data.

Coordinate Readout

Use Settings > Design File > Working Units to determine how MicroStation values are
displayed. This is helpful, for example, when you measure graphics. The CDOT standard

coordinate and angle readouts are shown below. These settings are copied over from the seed

file.

4 DGN File Settings 2
Category Modify Working Unit Settings

Active Angle Linear Units

Active Scale Format: (MU »| | Custom

s Master Unit: |Survey Fes = | Label: °

Color Sub Unit: [Survey Inc = | Label: | Cancel |
Element Attributes Accuracy [0.123 -

Fence

Grid Advanced Settings

lsometric Resolution: 12000 per Distance Survey Foot
Locks Working Area:  1.42155E+008 Miles

; Solids Area:  157.829 Miles ——

Renderin -
Snaps o Solids Accuracy:  8.33333E-006 Survey Feet Edit
Stream Angles =

Views Format; ([DDMMSS -

Working Units Mode: [Bearing hd

Accuracy: [}.12 hd
Focus ltem Description
Select category to view.

You can set your linear values to readout in master units, sub units or both. Angles can readout

in either degrees-minutes-seconds (DD MM SS) or decimal degrees (DD.DDDD) with up to 8
decimal place accuracy.
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Referencing other’s work

A Reference is a file that is attached to your active file, so that you can see the file’s graphics.
Reference graphics are not actually in your active file, but serve as background data. You
cannot modify reference graphics from the active file. You can, however, copy graphics from
the reference model to the active model and then modify them, if desired. Using references is a
good way to copy a large number of graphics from model to model.

The proper use of MicroStation References is critical to achieving two key components of the
CDOT MicroStation workflow:

1. Maintaining a single source for project data.
2. Sharing graphical data between specialty groups.

References allow multiple users to work on different parts of a project at the same time.
Multiple users can access the same reference from a central location (e.g. project directory on
the PM’s computer). Specialty groups can interact throughout the design process by referencing
other discipline-specific model files. The data exchange between disciplines is “real time”
when using MicroStation References.

References are useful in the plan set creation phase. You can “build” the sheets by referencing
in the individual model files (survey/topo, design, utilities, etc.) Each discipline’s Master
Model file can reference other discipline’s model files, as needed. The Master Model file can
then be referenced into a newly created sheet file. You can also reference in details and show
these at a different scale on the same sheet.

Attaching References

To attach references, select References from the Primary toolbar. In the References dialog box,
select Tools > Attach.

Primary Tools [

B-ofe-9-2-k-0uw-R

References

M References (2 of 2 unique, 2 displayed) =l @
Tools Settings

| (Boundares ]
Siot ¥ Fie Name Moded Description Logical Presertation [+] .J & & |
1 12345DE5_Model don CDOT Defauk Global Origin aligned with Master File Wireframe NN W
2 123450E5_Prof dgn CDOT Defauk  Global Origin aligned with Master File Wireframe o
Sgale | 1.000000 : | 1.000000 Orientation Top Flotation | 0°00"
Offset X | -178956.971 Y | -178556.971 2 |-178556.571 T —”E‘Eﬁ S ¢ [Hle _ 7

(NoMesting ] [Aow O New Level Display: (Config Variable +]

Different reference file attachment methods are available to help control reference
manipulations and displays. These include:

e No nesting
e Live nesting

e Copy attachments

Page 75 Colorado Department of Transportation



A Practical Guide for Using MicroStation XM Chapter 5 - CDOT MicroStation Workflow

Nested References

References can be attached nested — meaning you can attach a reference’s reference.

Scale | 1.000000 - [ 1.000000 Orientation Top Botation | 0°0'0"
Offset X | 0.000 Y [0.000 Z [0.000 &ILJ mf_}, m@ S ¢ [l _.g

ILi\re Nesting vl Allow Ovemides | Depth: | 1 New Level Display: |Config Variable -

The Nested Depth option determines how many reference levels deep you can attach. In the
example below, if the reference BridgeModel is attached to BridgePlanSheet(1 with No
Nesting, only the Bridge Model graphics are attached. If the nested depth is set to 1, you would
attach BridgeModel01 and DesignModel01. 1f the nested depth is set to 2, you would attach
BridgeModel01, DesignModel01, Survey/Topo and UtilityModel01.

12345BRDG_Plan01.dgn

(Sheet File)
Model Files
12345BRDG_Model.dgn
12345SURV_Topo.dgn 12345UTIL_Model.dgn Nested depth =2

The Live Nesting option allows you to dynamically update a reference’s sub-references after
the reference is attached. You can change your Live Nested Depth and your references will
automatically update without having to detach and reattach the reference.

The Copy Attachment Option

The Copy Attachment option allows you to dynamically make all nested references upper-
level references. This way, you can manipulate and control each reference display individually,
if needed. You can switch between nested references and the copy attachment at any time.

Scale | 1.000000 - [ 1.000000 Orientation Top Botation | 0°0'0"
Offset X | 0.000 ¥ [0.000 Z [0.000 Il EfE] > ¢ @ ® [@]@
Allow Ovemides | Depth: | 1 New Level Display: |Config Variable -
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Working with Raster Attachments

When you attach a reference, you have the option to Display Raster References. If the reference
has a raster image attached (e.g. aerial photo), you can choose to attach the raster with the
reference. You can toggle the raster reference on/off from the Reference dialog box.

Scale [1.000000 : [1.000000 Orientation Top Rotation [ 0'00"
Offsst X [0.000 ¥ [0.000 z [0.000 A NEEER 4«%@ EllE)
Allow Ovemides | Depth: | 1 Mew Level Display: Config Vanable »

i!Zlisplaw,r Raster References}»

For more information on working with raster references, see the CDOT Raster Manager
workflow.

Reference Levels

You can control each reference’s levels just like the master file levels. The Level Display box
shows a list of all attached references to the Master file. Select the reference and then turn the
reference level on/off.

M Level Display S
PIEFEIEFF (VeowDslay -~
\cj)}:'[none}v@i.ﬁv

=8 12345DES_PnF01.dgn
12345DES_Model dgn
12345DES_Prof.dgn

4 [m] »

»

Mame Logical Used

m| »
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